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Planning your BlackBerry environment

Choosing a BlackBerry Enterprise Server setup type
The BlackBerry® Enterprise Server consists of services and components. The BlackBerry services are designed to 
provide productivity tools—such as email, instant messaging, and organizer functionality—and data from 
enterprise applications to mobile users. The BlackBerry components are designed to monitor BlackBerry services; 
process, route, compress, and encrypt data; and communicate with the wireless network.

You can install all BlackBerry components on one computer, or you can install particular components on separate 
computers. Consider any impacts on system resources when deciding where to install a component.

You can choose only one setup type for each computer in your environment. 

Choosing a BlackBerry Enterprise Server setup type
Upgrading the BlackBerry Enterprise Server

Warning: After you choose a setup type, you cannot modify it. You must remove one setup type before you can install 
another.

Setup type Description Considerations

BlackBerry 
Enterprise Server

This setup type installs all BlackBerry components, except 
the BlackBerry MDS Services.

—

BlackBerry MDS 
Services

This setup type installs the BlackBerry Controller and the 
following BlackBerry MDS Services on a remote computer:

• BlackBerry MDS Application Integration Service 

• BlackBerry MDS Data Optimization Service 

• BlackBerry MDS Provisioning Service

• BlackBerry MDS Administrative and Management 
Service 

• BlackBerry® MDS Studio Application Repository 

A remote instance of the BlackBerry MDS Services can 
support multiple BlackBerry Enterprise Servers and one 
BlackBerry MDS Studio Application Repository. 

The BlackBerry MDS Services might use increased system 
resources when it processes content requests. Install an 
instance of the BlackBerry MDS Services on a remote 
computer to minimize the impact on message delivery.

You must install the BlackBerry MDS Studio Application 
Repository on the same database server as the BlackBerry 
Configuration Database. 

BlackBerry 
Enterprise Server 
with BlackBerry 
MDS Services

This setup type installs all BlackBerry components, 
including the BlackBerry MDS Services.

—

BlackBerry 
Attachment 
Service

This setup type installs the BlackBerry Attachment Service 
and the BlackBerry Controller on a remote computer. 

A remote BlackBerry Attachment Service can support 
multiple BlackBerry Enterprise Servers. 

The BlackBerry Attachment Service might use increased 
system resources when it processes concurrent conversion 
requests. Install the BlackBerry Attachment Service on a 
remote computer to increase the number of concurrent 
conversions without impacting message delivery.
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BlackBerry 
Manager

This setup type installs the BlackBerry Manager on a 
remote computer.

A remote BlackBerry Manager enables you to manage 
multiple BlackBerry Domains from your computer.

BlackBerry Router This setup type installs the BlackBerry Router and the 
BlackBerry Controller on a remote computer.

A remote BlackBerry Router can support multiple 
BlackBerry Enterprise Servers and is designed to provide 
wireless network bypass to BlackBerry devices. 

The BlackBerry Router does not use many system resources, 
but it is a critical connection point for the BlackBerry® 
Enterprise Solution. You can install several standby 
BlackBerry Routers as failover locations in case your 
primary BlackBerry Router is unavailable.

BlackBerry MDS 
Connection 
Service

This setup type installs the BlackBerry MDS Connection 
Service and the BlackBerry Controller on a remote 
computer.

A remote BlackBerry MDS Connection Service can support 
multiple BlackBerry Enterprise Servers.

The BlackBerry MDS Connection Service might use 
increased system resources when it processes content 
requests. Install the BlackBerry MDS Connection Service on 
a remote computer to minimize the impact on message 
delivery. 

Setup type Description Considerations
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1: Planning your BlackBerry environment
Upgrading the BlackBerry Enterprise Server
See the BlackBerry Enterprise Server Version 4.1.4 Upgrade Guide for more information.

BlackBerry 
Collaboration 
Service

This setup type installs the BlackBerry Collaboration 
Service, the BlackBerry Instant Messaging Connector, and 
the BlackBerry Controller on a remote computer.

A remote BlackBerry Collaboration Service can support 
multiple BlackBerry Enterprise Servers.

Your instant messaging environment can be IBM® Lotus® 
Sametime®, Microsoft® Live Communications Server 
2005™, or Novell® GroupWise® Messenger. Your choice is 
not limited by your messaging server.

You can install only one type of the BlackBerry 
Collaboration Service, and users can use only one type of 
enterprise instant messaging application on the BlackBerry 
device.

The BlackBerry Collaboration Service requires the following 
persistent connections, based on your instant messaging 
environment:

• If your instant messaging server is Microsoft Live 
Communications Server 2005 and you are using 
Transport Layer Security (TLS) as the communication 
protocol, you require one persistent socket connection 
for each instant messaging session.

• If your instant messaging server is Microsoft Live 
Communications Server 2005 and you are using 
Transmission Control Protocol (TCP) as the 
communication protocol, you require three persistent 
socket connections for each instant messaging session.

• If your instant messaging server is Microsoft Live 
Communications Server 2005 and you are using 
Hypertext Transfer Protocol over Secure Sockets Layer 
(HTTPS) as the communication protocol, you require 
three persistent socket connections to create one TCP 
connection, and all instant messaging sessions use that 
connection. 

• If your instant messaging server is Sametime, you 
require three persistent socket connections to create 
one TCP connection, and all instant messaging sessions 
use that connection.

• If your instant messaging server is GroupWise 
Messenger, you require one persistent socket 
connection for each instant messaging session.

Install the BlackBerry Collaboration Service on a remote 
computer to maximize the number of available sockets. 

Setup type Description Considerations
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System requirements

Hardware requirements
Visit www.blackberry.com/knowledgecenterpublic to read the BlackBerry Enterprise Server Version 4.1 for 
Microsoft Exchange Server Capacity Calculator and the BlackBerry Enterprise Server Version 4.1 for Microsoft 
Exchange Performance Benchmarking for more information about calculating hardware requirements based on 
the expected use of the BlackBerry Enterprise Server in your environment.

System requirements for the BlackBerry Enterprise Server
You must confirm that the computer on which you plan to install the BlackBerry Enterprise Server meets the 
system requirements.  

Hardware requirements
System requirements for the BlackBerry Enterprise Server
System requirements for your corporate environment
System requirements for remote components

Checklists Description Reference

Checklist: Operating system requirements This checklist describes the operating system software and settings 
that are required on the computer on which you plan to install the 
BlackBerry Enterprise Server.

See page 12.

Checklist: Messaging and collaboration 
server software requirements 

This checklist describes the messaging server software and settings 
that are required on the computer on which you plan to install the 
BlackBerry Enterprise Server.

See page 13.

Checklist: Security support requirements This checklist describes the security software that is required on the 
computer on which you plan to install the BlackBerry Enterprise Server, 
if you want to support specific security features.

See page 13.

Checklist: Multilanguage support 
requirements

This checklist describes the configuration that is required on the 
computer on which you plan to install the BlackBerry Enterprise Server, 
if you want to support localized message content.

See page 14.

Checklist: Virtual computer support 
requirements

This checklist describes the configuration that is required on the 
computer on which you plan to install the BlackBerry Enterprise Server, 
if you have a virtual computer environment.

See page 14.

Checklist: Additional software requirements This checklist describes the additional software that is required on the 
computer on which you plan to install the BlackBerry Enterprise Server, 
if you want to read the documentation and help file, or if you want to 
implement multiple BlackBerry devices from a single computer.

See page 14.

http://www.blackberry.com/knowledgecenterpublic
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Checklist: Operating system requirements  
Note: You must install the most current service pack for each Microsoft product. 

Considerations

Install one of the following operating systems on the computer on which you plan to install the BlackBerry Enterprise Server:

• Microsoft® Windows® 2000 Service Pack (SP) 4 (Server or Advanced Server editions)

• Microsoft® Windows Server® 2003 (SP1 is required for Microsoft Windows Messenger support and if you are using Microsoft 
Exchange 2007)

Install Microsoft Messaging Queue (MSMQ) Version 3.0 (required for Microsoft Windows Messenger support).

Note: If you install MSMQ separately from Windows Server 2003, clear the default Active Directory Integration and Triggers 
subcomponents and select only the Common subcomponent. 

Install Microsoft® .NET Framework Version 1.1 (SP1 is required for Microsoft Windows Messenger support). You can install this 
program during the BlackBerry Enterprise Server installation.

If Microsoft .NET Framework Version 2.0 is installed, the setup program still installs Version 1.1 or Version 1.1 SP1.

If Microsoft .NET Framework Version 1.1 is installed in a language other than English, you must download and install SP1 in the 
appropriate language.

Visit www.microsoft.com/netframework/downloads/ for more information.

Install one of the following Microsoft Data Access Component (MDAC) versions on the computer on which you plan to install the 
BlackBerry Enterprise Server:

• MDAC Version 2.8 with Security Patch MS04-003 (Version 2000.85.1025.00)

• MDAC Version 2.8 SP2 (Version 2000.86.1830.00)

Note: MDAC Version 2.8 SP2 is shipped only with Microsoft Windows Server 2003 SP1.

Install Java® 2 Platform, Standard Edition (J2SE™) Runtime Environment Version 5.0 update 9. You can install this program during 
the BlackBerry Enterprise Server installation.

If you are using Microsoft Exchange 2007, install the Internet Service Manager component of Internet Information Services from 
your Microsoft Windows installation media
12
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2: System requirements
Checklist: Messaging and collaboration server software requirements 

Checklist: Security support requirements

Warning: Do not install Microsoft® Outlook® on the same computer as the BlackBerry Enterprise Server. Visit 
www.support.microsoft.com/kb/266418 for more information.

Considerations

Install one of the following Microsoft Exchange administration tools on the computer on which you plan to install the BlackBerry 
Enterprise Server:

• Microsoft Exchange Version 5.5 Administrator

• Microsoft Exchange 2000 System Manager

• Microsoft Exchange 2003 System Manager

• Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 (see http://support.microsoft.com/kb/929590 
for more information)

• if you are using Microsoft Exchange 2007, either Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 
or Microsoft Exchange 2003 System Tools with SP2

Note: Do not install Microsoft Exchange 2007 on the computer on which you plan to install the BlackBerry Enterprise Server.

Install the BlackBerry Enterprise Server in the same Microsoft Exchange Organization as your messaging server.

Review the Microsoft known issues that impact wireless calendar synchronization. See “Configuring Microsoft Exchange to 
support wireless calendar synchronization” on page 28 for more information.

If you are using Microsoft Exchange 2003 and use unicode text in calendars, download and install the following hotfixes:

• visit http://support.microsoft.com/kb/913643 to install the hotfix on the messaging server

• visit http://support.microsoft.com/kb/923537/en-us to install the hotfix on the computer on which you will install the 
BlackBerry Enterprise Server

If your instant messaging environment supports Microsoft Windows Messenger and you are using TLS as the communication 
protocol, you must install or import one of the following certificates on the computer on which you plan to install the BlackBerry 
Enterprise Server:

• If your instant messaging server is Microsoft Live Communications Server 2005, you must install or import a Mutual TLS 
(MTLS) certificate.

• If your instant messaging server is Microsoft Live Communications Server 2005 SP1, you must install or import a server 
authentication certificate under the computer account.

Visit www.office.microsoft.com/en-us/FX011526591033.aspx for more information about configuring certificates on Microsoft 
Live Communications Server 2005.

If your instant messaging server is Sametime, you must add the IP address of each computer on which you plan to install the 
BlackBerry Collaboration Service to the CommunityConnectivity document on the Sametime server.

If your instant messaging server is GroupWise Messenger, you must turn on support for Secure Sockets Layer (SSL) authentication 
of the Novell GroupWise Messenger agents on the computer on which you plan to install the BlackBerry Collaboration Service. 
Visit www.novell.com/documentation to read the Messenger 1.0 Administration Guide for more information.

Considerations

If you are using RSA® SecurID® authentication, you must install the Security Dynamics Technologies Ace/Agent® for Microsoft 
Windows Version 5.0 on the computer on which you plan to install the BlackBerry MDS Connection Service. 
13
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Checklist: Multilanguage support requirements

Checklist: Virtual machine support requirements

Checklist: Additional software requirements

System requirements for your corporate environment
You must confirm that settings in your network, messaging and collaboration, instant messaging, and database 
environments are configured to support the BlackBerry Enterprise Server.

Considerations

Set your language preferences in Microsoft® Internet Explorer® to display encoded web pages correctly. 

Considerations

Install VMware® ESX Server Version 2.5.2 on the computer on which you plan to install the BlackBerry Enterprise Server. 

Considerations

If you run a Universal Serial Bus (USB) hub to implement BlackBerry devices while connected to the BlackBerry Manager, verify 
that the USB driver supports USB1.1-compliant hubs.

Install Adobe® Acrobat® Reader® Version 3.0 or later so that you can view the product guides.

Set Microsoft Internet Explorer Version 4.0 or later with Java or JavaScript® enabled as your default browser so that you can view 
the online help.

Install Microsoft® XML Parser Version 4.0 SP2 or later. You can install this program during the BlackBerry Enterprise Server 
installation.

If you are using SNMP monitoring, you must install the SNMP service before you install the BlackBerry Enterprise Server. Visit 
www.microsoft.com/technet/itsolutions/network/deploy/confeat/snmp.mspx for more information about installing and 
configuring the SNMP service.

Install Microsoft® Windows Media® Player Version 9 or later to support audio attachments.

Checklists Description Reference

Checklist: Network environment settings This checklist describes how your BlackBerry Enterprise Server must 
connect to your firewall.

See page 15.

Checklist: Messaging and collaboration 
environment settings

This checklist describes the software and settings that are required on 
your messaging server and your desktop email program.

See page 15.

Checklist: Instant messaging environment 
settings

This checklist describes the software and settings that are required on 
your instant messaging server.

See page 15.

Checklist: Terminal service settings This checklist describes the supported software and settings for 
installing the BlackBerry Enterprise Server using a terminal or remote 
desktop session.

See page 16.

Checklist: Database environment settings This checklist describes the software and settings that are required on 
your database server.

See page 16.
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2: System requirements
Checklist: Network environment settings

Checklist: Messaging and collaboration environment settings

Checklist: Instant messaging environment settings

Considerations

Verify that the BlackBerry Enterprise Server is physically close to the messaging servers. Use a high-speed switched connection 
between the BlackBerry Enterprise Server and the messaging servers. Network latency impacts the performance of the BlackBerry 
Enterprise Server. 

Verify that the BlackBerry Enterprise Server is not installed in a perimeter network (demilitarized zone). Visit  
www.blackberry.com/knowledgecenterpublic to read article TAE-00038 for more information.

Verify that you have configured the corporate firewall or proxy to permit the BlackBerry Enterprise Server to initiate and maintain 
an outbound connection to the BlackBerry® Infrastructure on TCP port 3101. 

Verify that the corporate firewall can resolve Internet addresses using the Domain Name System (DNS).

Verify that the proxy server is transparent, if you are using a proxying firewall. 

Considerations

Your messaging environment must be one of the following:

• Microsoft Exchange Version 5.5 native environment 

• Microsoft Exchange 2000 native environment 

• Microsoft Exchange 2003 native environment 

• Microsoft Exchange 2007 native environment

• mixed environment (any combination of Microsoft Exchange Version 5.5, Microsoft Exchange 2000, Microsoft Exchange 
2003, and Microsoft Exchange 2007)

Note: Do not install Microsoft Exchange 2007 on the computer on which you plan to install the BlackBerry Enterprise Server.

Considerations

Your instant messaging server must be one of the following:

• Sametime Version 3.0 Community Server

• Sametime Version 3.1 Community Server

• Sametime Version 6.5.1 Community Server (Version 6.5.1 or later is required to support dormant mode.)

• Sametime Version 7.0 Community Server

• Sametime Version 7.5 Community Server

• Microsoft Live Communications Server 2005 (SP1 is required to support Microsoft Office Communicator and dormant mode.)

• Novell GroupWise Messenger Server Version 1.0.2 or later

• Novell GroupWise Messenger Server Version 2.0

If your instant messaging environment supports Microsoft Office Communicator, your environment must also include a Microsoft 
Office Communicator Web Access Server. 

Verify that your Communicator Web Access Server meets the following criteria:

• includes the MTLS and HTTPS certificates required for communication with your Microsoft Live Communications Server

Visit office.microsoft.com/en-us/assistance/HA100240791033.aspx for more information.
15
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Checklist: Terminal service settings

Checklist: Database environment settings

If your instant messaging environment supports Microsoft Office Communicator, you must download and install the following 
hotfixes to support the AJAX Service: 

• visit www.support.microsoft.com/kb/911996 to install the hotfix on your Microsoft Live Communications Server

• visit www.support.microsoft.com/kb/915066 to install the hotfix on your Communicator Web Access server

If your instant messaging environment supports Microsoft Office Communicator, you must install or configure an additional 
virtual server to support the AJAX Service on your Communicator Web Access server that meets the following criteria:

• uses all unassigned IP addresses

• uses forms-based authentication only (RIM does not recommend using integrated authentication when supporting HTTPS 
connections) 

• supports HTTPS browser connections

• contains an Internet Server API (ISAPI) filter for both the cwaauth.dll file and the ajax.dll file

Visit office.microsoft.com/en-us/assistance/HA100240791033.aspx to read the Microsoft Office Communicator Web Access 
Planning and Deployment Guide for more information about enabling the AJAX Service for Communicator Web Access.

Considerations

If your operating system is Microsoft Windows Server 2000, you can install and access the BlackBerry Enterprise Server using the 
Terminal Services program.

You must install the Terminal Services program using Remote Administration mode. Visit www.support.microsoft.com/kb/306624 
for more information.

Note: RIM does not recommend using Application Server mode. If you install the Terminal Services program using Application 
Server mode and then install the BlackBerry Enterprise Server, unpredictable results might occur.

If your operating system is Microsoft Windows Server 2003, you can install and access the BlackBerry Enterprise Server using the 
Microsoft Remote Desktop Connection program that is included with Microsoft Windows Server 2003.

Note: Do not install the Terminal Services program. If you install the Terminal Services program on Microsoft Windows Server 
2003, the Terminal Services program installs in Application Server mode automatically, which RIM does not recommend.

Considerations

Install one of the following database programs on the computer on which you plan to install the BlackBerry Configuration 
Database:

• Microsoft® SQL Server™ 2000 Desktop Engine (MSDE 2000)

• Microsoft SQL Server 2000 SP4

• Microsoft SQL Server 2005 (Standard, Enterprise, or Express)

Notes: If you are installing BlackBerry MDS Services, you cannot use Microsoft SQL Server 2005 Express as your database 
program.

You can install MSDE 2000 during the BlackBerry Enterprise Server installation.

Install one of the following MDAC versions on the computer on which you plan to install the BlackBerry Configuration Database:

• MDAC Version 2.8 with Security Patch MS04-003 (Version 2000.85.1025.00)

• MDAC Version 2.8 SP2 (Version 2000.86.1830.00)

MDAC Version 2.8 SP2 is shipped only with Microsoft Windows Server 2003 SP1.

Considerations
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2: System requirements
System requirements for remote components
If you plan to install BlackBerry components on remote computers, you must confirm that those computers meet 
the system requirements.

You must manage the BlackBerry Configuration Database using a BlackBerry Manager that is configured to support the database 
management system (DBMS) type. You select the DBMS type of the BlackBerry Manager during the BlackBerry Enterprise Server 
installation.

The version of MSDE 2000 (MSDE 2000 Release A) provided with the BlackBerry Enterprise Server does not support upgrading 
from a previous version of MSDE. Visit www.support.microsoft.com/kb/829925 for more information.

If you are using Microsoft SQL Server, install the program using the default case-insensitive collation setting. The collation setting 
for the BlackBerry Configuration Database must be the same as the collation setting for the database server.

If you are using Microsoft SQL Server, you can install the BlackBerry Configuration Database on a nondefault instance. During 
the installation process, you can specify servername\instancename. 

If the BlackBerry Configuration Database is on a remote computer or you want to use a remote BlackBerry Manager, you must 
enable named pipes and TCP/IP network protocols.

If you are installing the BlackBerry MDS Services, you must install the BlackBerry MDS Services databases on the same DBMS and 
on the same database server as the BlackBerry Configuration Database.

If you are installing the BlackBerry MDS Services and if you are using Microsoft SQL Server, the Microsoft SQL Server must support 
mixed-mode authentication. If you install the BlackBerry Configuration Database on MSDE 2000, you receive a prompt to accept 
this change in authentication.

If you are installing the BlackBerry MDS Services, you must use SQL authentication to create the BlackBerry MDS Services 
databases.

If you are using SQL authentication to create the BlackBerry Configuration Database, you must use a different SQL account to 
create the BlackBerry MDS Services databases.

Note: The BlackBerry MDS Services store their BlackBerry MDS Services database access credentials in plain text form in 
<installation directory>\MDSS\jakarta-tomcat-5.5.9\conf\server.xml. To protect the access credentials in that storage location, 
you must limit read and write control to that location.

Checklists Description Reference

Checklist: BlackBerry MDS Services system 
requirements 

This checklist describes the software and settings that are required on 
the computer on which you plan to install the BlackBerry MDS Services.

See page 18.

Checklist: BlackBerry Enterprise Server with 
the BlackBerry MDS Services system 
requirements 

This checklist describes the software and settings that are required on 
the computer on which you plan to install the BlackBerry Enterprise 
Server with BlackBerry MDS Services.

See page 19.

Checklist: BlackBerry Attachment Service 
system requirements

This checklist describes the software and settings that are required on 
the computer on which you plan to install the BlackBerry Attachment 
Service.

See page 21.

Checklist: BlackBerry Manager system 
requirements

This checklist describes the software and settings that are required on 
the computer on which you plan to install the BlackBerry Manager.

See page 22.

Checklist: BlackBerry Router system 
requirements 

This checklist describes the software and settings that are required on 
the computer on which you plan to install the BlackBerry Router.

See page 23.

Checklist: BlackBerry MDS Connection 
Service system requirements 

This checklist describes the software and settings that are required on 
the computer on which you plan to install the BlackBerry MDS 
Connection Service.

See page 23.

Considerations
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Checklist: BlackBerry MDS Services system requirements 

Checklist: BlackBerry Collaboration Service 
system requirements 

This checklist describes the software and settings that are required on 
the computer on which you plan to install the BlackBerry Collaboration 
Service.

See page 24.

System 
requirement Considerations

operating 
system

Install one of the following operating systems on the computer on which you plan to install the BlackBerry MDS 
Services:

• Microsoft Windows 2000 (Server or Advanced Server editions)

• Microsoft Windows Server 2003 (Standard, Enterprise or Small Business Server)

• Microsoft Windows XP

Verify that the operating system is installed in one of English, French, German, Italian, or Spanish.

additional 
software

Install Adobe Acrobat Reader Version 3.0 or later so that you can view the product guides.

Checklists Description Reference
18



2: System requirements
Checklist: BlackBerry Enterprise Server with the BlackBerry MDS Services 
system requirements

System 
requirement Considerations

operating 
system

Install one of the following operating systems on the computer on which you plan to install the BlackBerry 
Enterprise Server with BlackBerry MDS Services:

• Microsoft Windows 2000 SP4 (Server or Advanced Server editions)

• Microsoft Windows Server 2003 (Standard, Enterprise or Small Business Server), and, if you are using 
Microsoft Exchange 2007, with SP1

Install MSMQ Version 3.0 (required for Microsoft Windows Messenger support).

Note: If you install MSMQ separately from Windows Server 2003, clear the default Active Directory Integration 
and Triggers subcomponents and select only the Common subcomponent. 

Install Microsoft .NET Framework Version 1.1 SP1. You can install this program during the BlackBerry Enterprise 
Server installation.

If Microsoft .NET Framework Version 2.0 is installed, the setup program still installs Version 1.1 or Version 1.1 SP1.

If Microsoft .NET Framework Version 1.1 is installed in a language other than English, you must download and 
install SP1 in the appropriate language. Visit www.microsoft.com/netframework/downloads/ for more 
information.

Install one of the following MDAC versions:

• MDAC Version 2.8 with Security Patch MS04-003 (Version 2000.85.1025.00)

• MDAC Version 2.8 SP2 (Version 2000.86.1830.00)

Note: MDAC Version 2.8 SP2 is shipped only with Microsoft Windows Server 2003 SP1.

Install J2SE Runtime Environment Version 5.0 update 9. You can install this program during the BlackBerry 
Enterprise Server installation.

If you are using Microsoft Exchange 2007, install the Internet Service Manager component of Internet 
Information Services from your Microsoft Windows installation media.
19
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messaging and 
collaboration 
server software

Install one of the following Microsoft Exchange administration tools on the computer on which you plan to 
install the BlackBerry Enterprise Server with BlackBerry MDS Services:

• Microsoft Exchange Version 5.5 Administrator

• Microsoft Exchange 2000 System Manager

• Microsoft Exchange 2003 System Manager

• Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 (see http://
support.microsoft.com/kb/929590 for more information)

• if you are using Microsoft Exchange 2007, either Microsoft Exchange Server MAPI Client and Collaboration 
Data Objects 1.2.1 or Microsoft Exchange 2003 System Tools with SP2

Review the Microsoft known issues that impact wireless calendar synchronization.

Install the BlackBerry Enterprise Server in the same Microsoft Exchange Organization as your messaging server.

Note: Do not install Microsoft Exchange 2007 on the computer on which you plan to install the BlackBerry 
Enterprise Server with MDS Services.

If you are using Microsoft Exchange 2003 and use unicode text in calendars, download and install the following 
hotfixes:

• visit http://support.microsoft.com/kb/913643 to install the hotfix on the messaging server

• visit http://support.microsoft.com/kb/923537/en-us to install the hotfix on the computer on which you will 
install the BlackBerry Enterprise Server

messaging and 
collaboration 
server software, 
continued

If your instant messaging environment supports Microsoft Windows Messenger and you are using TLS as the 
communication protocol, you must install or import one of the following certificates on the computer on which 
you plan to install the BlackBerry Collaboration Service:

• If your instant messaging server is Microsoft Live Communications Server 2005, you must install or 
import an MTLS certificate.

• If your instant messaging server is Microsoft Live Communications Server 2005 SP1, you must install or 
import a server authentication certificate under the computer account.

Visit www.office.microsoft.com/en-us/FX011526591033.aspx for more information about configuring 
certificates on Microsoft Live Communications Server 2005.

If your instant messaging server is Sametime, you must add the IP address of each computer on which you plan 
to install the BlackBerry Collaboration Service to the CommunityConnectivity document on the Sametime 
server.

If your instant messaging server is Novell GroupWise Messenger, you must turn on support for SSL 
authentication of the Novell GroupWise Messenger agents on the computer on which you plan to install the 
BlackBerry Collaboration Service. Visit www.novell.com/documentation to read the Messenger 1.0 
Administration Guide for more information.

multilanguage 
support 

Set your language preferences in Microsoft Internet Explorer to display encoded web pages correctly. 

security 
support 

If you are using RSA SecurID authentication, you must install the Security Dynamics Technologies Ace/Agent 
for Microsoft Windows Version 5.0 on the computer on which you plan to install the BlackBerry MDS Connection 
Service. 

System 
requirement Considerations
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2: System requirements
Checklist: BlackBerry Attachment Service system requirements

additional 
software 

If you run a USB hub to implement BlackBerry devices that are connected to the BlackBerry Manager, verify that 
the USB driver supports USB1.1-compliant hubs.

Install Adobe Acrobat Reader Version 3.0 or later so that you can view the product guides.

Set Microsoft Internet Explorer Version 4.0 or later with Java or JavaScript enabled as your default browser so 
that you can view the online help.

Install Microsoft XML Parser Version 4.0 SP2 or later. You can install this program during the BlackBerry 
Enterprise Server installation.

If you are using SNMP monitoring, you must install the SNMP service before you install the BlackBerry 
Enterprise Server. Visit www.microsoft.com/technet/itsolutions/network/deploy/confeat/snmp.mspx for more 
information about installing and configuring the SNMP service.

Install Microsoft Windows Media Player Version 7.1 or later so that you can support audio attachments.

System 
requirement Considerations

operating 
system

Install one of the following operating systems on the computer on which you plan to install the BlackBerry 
Attachment Service:

• Microsoft Windows 2000 SP4 (Server or Advanced Server editions)

• Microsoft Windows Server 2003

• Microsoft Windows XP

multilanguage 
support 

Set your language preferences in Microsoft Internet Explorer to display encoded web pages correctly. 

additional 
software 

Install Adobe Acrobat Reader Version 3.0 or later so that you can view the product guides.

Set Microsoft Internet Explorer Version 4.0 or later with Java or JavaScript enabled as your default browser so 
that you can view the online help.

Install Microsoft XML Parser Version 4.0 SP2 or later. You can install this program during the BlackBerry 
Enterprise Server installation.

Install Microsoft Windows Media Player Version 7.1 or later so that you can support audio attachments.

System 
requirement Considerations
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Checklist: BlackBerry Manager system requirements

System 
requirement Considerations

operating 
system

Install one of the following operating systems on the computer on which you plan to install the BlackBerry 
Manager:

• Microsoft Windows 2000 (Professional, Server, or Advanced Server editions)

• Microsoft Windows Server 2003

• Microsoft Windows XP Professional

Install Microsoft .NET Framework Version 1.1 SP1. You can install this program during the BlackBerry Enterprise 
Server installation.

If Microsoft .NET Framework Version 2.0 is installed, the setup program still installs Version 1.1 or Version 1.1 SP1.

If Microsoft .NET Framework Version 1.1 is installed in a language other than English, you must download and 
install SP1 in the appropriate language. Visit www.microsoft.com/netframework/downloads/ for more 
information.

In the operating system, turn on printer and file sharing to implement BlackBerry devices.

If you are using Microsoft Exchange 2007, install the Internet Service Manager component of Internet 
Information Services from your Microsoft Windows installation media.

messaging and 
collaboration 
server software

Install one of the following on the computer on which you plan to install the BlackBerry Manager:

• Microsoft Exchange Version 5.5 Administrator

• Microsoft Exchange 2000 System Manager

• Microsoft Exchange 2003 System Manager

• Microsoft Outlook 2000 (Corporate or Workgroup installation)

• Microsoft Outlook 2002 (XP) (Corporate or Workgroup installation)

• Microsoft Outlook 2003 (Corporate or Workgroup installation)

• Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 (see http://
support.microsoft.com/kb/929590 for more information)

• if you are using Microsoft Exchange 2007, either Microsoft Exchange Server MAPI Client and Collaboration 
Data Objects 1.2.1 or Microsoft Exchange 2003 System Tools with SP2

multilanguage 
support 

Set your language preferences in Microsoft Internet Explorer to display encoded web pages correctly. 

additional 
software 

Install Adobe Acrobat Reader Version 3.0 or later so that you can view the product guides.

Set Microsoft Internet Explorer Version 4.0 or later with Java or JavaScript enabled as your default browser so 
that you can view the online help.

Install Microsoft XML Parser Version 4.0 SP2 or later. You can install this program during the BlackBerry 
Enterprise Server installation.
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2: System requirements
Checklist: BlackBerry Router system requirements

Checklist: BlackBerry MDS Connection Service system requirements

System 
requirement Considerations

operating 
system

Install one of the following operating systems on the computer on which you plan to install the BlackBerry 
Router:

• Microsoft Windows 2000 (Server or Advanced Server editions)

• Microsoft Windows Server 2003

• Microsoft Windows XP

additional 
software 

Install Adobe Acrobat Reader Version 3.0 or later so that you can view the product guides.

Install Microsoft XML Parser Version 4.0 SP2 or later. You can install this program during the BlackBerry 
Enterprise Server installation.

network 
environment 
settings

You can install the BlackBerry Router in a perimeter network (demilitarized zone).

Verify that the firewall settings permit the BlackBerry Router computer to initiate a two-way TCP/IP connection 
to an external server on port 3101.

Verify that the corporate firewall can resolve Internet addresses using the DNS.

Verify that the proxy is transparent, if you are using a proxying firewall. 

System 
requirement Considerations

operating 
system

Install one of the following operating systems on the computer on which you plan to install the BlackBerry MDS 
Connection Service:

• Microsoft Windows 2000 (Server or Advanced Server editions)

• Microsoft Windows Server 2003

• Microsoft Windows XP

security 
support 

If you are using RSA SecurID authentication, you must install the Security Dynamics Technologies Ace/Agent 
for Microsoft Windows Version 5.0 on the computer on which you plan to install the BlackBerry MDS Connection 
Service.

additional 
software 

Install Adobe Acrobat Reader Version 3.0 or later so that you can view the product guides.
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Checklist: BlackBerry Collaboration Service system requirements

System 
requirement Considerations

operating 
system

Install one of the following operating systems on the computer on which you plan to install the BlackBerry 
Collaboration Service:

• Microsoft Windows 2000 (Server or Advanced Server editions)

• Microsoft Windows Server 2003 SP1 (required for Microsoft Windows Messenger support)

• Microsoft Windows XP

Install Microsoft .NET Framework Version 1.1 SP1 (required for Microsoft Windows Messenger support). You can 
install this program during the BlackBerry Enterprise Server installation.

If Microsoft .NET Framework Version 2.0 is installed, the setup program still installs Version 1.1 or Version 1.1 SP1

If Microsoft .NET Framework Version 1.1 is installed in a language other than English, you must download and 
install SP1 in the appropriate language. Visit www.microsoft.com/netframework/downloads/ for more 
information.

Install MSMQ Version 3.0 (required for Microsoft Windows Messenger support).

Note: If you install MSMQ separately from Windows Server 2003, clear the default Active Directory Integration 
and Triggers subcomponents and select only the Common subcomponent. If you are using Microsoft Exchange 
2007, install the Internet Service Manager component of Internet Information Services from your Microsoft 
Windows installation media.

messaging and 
collaboration 
server software

If your instant messaging environment supports Microsoft Windows Messenger and you are using TLS as the 
communication protocol, you must install or import one of the following certificates on the computer on which 
you plan to install the BlackBerry Collaboration Service:

• If your instant messaging server is Microsoft Live Communications Server 2005, you must install or 
import a MTLS certificate.

• If your instant messaging server is Microsoft Live Communications Server 2005 SP1, you must install or 
import a server authentication certificate under the computer account.

Visit www.office.microsoft.com/en-us/FX011526591033.aspx for more information about configuring 
certificates on Microsoft Live Communications Server 2005.

If your instant messaging server is Sametime, you must add the IP address of each computer on which you plan 
to install the BlackBerry Collaboration Service to the CommunityConnectivity document on the Sametime 
server.

If your instant messaging server is Novell GroupWise Messenger, you must turn on support for SSL 
authentication of the Novell GroupWise Messenger agents on the computer on which you plan to install the 
BlackBerry Collaboration Service. Visit www.novell.com/documentation to read the Messenger 1.0 
Administration Guide for more information.

additional 
software 
requirement

Install Adobe Acrobat Reader Version 3.0 or later so that you can view the product guides.
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Configuring your environment

Enabling the messaging environment to communicate with 
the BlackBerry Enterprise Server
You must create and configure a service (user) account and mailbox in the Microsoft® Active Directory® directory 
service for the BlackBerry Enterprise Server and the BlackBerry Manager so that these BlackBerry components 
can be authenticated on the Microsoft Exchange Server.

Create a service account and mailbox
> Perform one of the following actions:

Enabling the messaging environment to communicate with the BlackBerry Enterprise Server
Setting database permissions

Action Procedure

Create a service account and mailbox 
when using Microsoft Exchange 
Version 5.5, Microsoft Exchange 
2000, or Microsoft Exchange 2003.

1. On the taskbar, click Start > Programs > Administrative Tools > Active Directory Users and 
Computers. 

2. Create an account with the following attributes:

• Name: BESAdmin

• User location: create a Microsoft Exchange mailbox 

• Group membership: Domain User

You might not be able to see the service account to confirm that it has been created.

3. Give this account the Send As permission for all user accounts in the User container of your 
Active Directory domain.

4. Initialize the new mailbox by sending a test message.

Create a Microsoft Exchange account 
and mailbox when using Microsoft 
Exchange 2007.

1. Log in to the Microsoft Exchange computer as an administrator with permission to set up a 
service account.

2. Open the Exchange Management Console. 

3. Create a new service account with the name BESAdmin. 
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Configure Microsoft Windows permissions for the service account 
> Perform one of the following actions:

Configure Microsoft Exchange permissions for the service account 
> Perform one of the following actions:

Action Procedure

Configure Microsoft Windows 
permissions for the service account 
when using Microsoft Exchange 
Version 5.5, Microsoft Exchange 
2000, or Microsoft Exchange 2003.

You must set the permissions on each computer where you plan to install the BlackBerry 
components.

1. On the taskbar, click Start > Programs > Administrative Tools > Local Security Policy.

2. Give the service account the following permissions:

• log on locally with local permissions (if not assigned by default)

• log on as a service

3. On the taskbar, click Start > Programs > Administrative Tools > Computer Management. 

4. Add the service account to the local Administrators group.

Set Local Security Policy permissions 
for the BESAdmin service account 
when using Microsoft Exchange 
2007.

1. Right-click My Computer.

2. Click Manage.

3. In the left pane, expand Local Users and Groups.

4. Browse to the Groups folder.

5. In the right pane, double-click the Administrators group.

6. Click Add.

7. In the Enter the object names to select field, type BESAdmin.

8. Click OK.

9. Click Apply.

10. Click OK.

Action Procedure

Set the permissions using Microsoft 
Exchange Version 5.5 Administrator.

> In both the Site and Configuration containers, set the Service Account Admin permission.

You must configure the permissions on each computer where you plan to install the BlackBerry 
components.

Set the permissions using Microsoft 
Exchange 2000 or Microsoft 
Exchange 2003 System Manager.

1. Set Exchange View Only Administrator permission with Administrative Groups as the 
minimum access level

2. Set Send As, Receive As, and Administer Information Store permissions at the server level.

You must configure the permissions on each computer where you plan to install the BlackBerry 
components.
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Enable BlackBerry users to send messages when using Microsoft Exchange 
2007
1. On the taskbar, click Start > Administrative Tools > Active Directory Users and Computers.

2. On the View menu, click Advanced Features.

3. Right-click the root of the domain.

4. Click Properties.

5. On the Security tab, click Advanced.

6. Click Add.

7. Type BESAdmin.

8. Click Check Name.

9. Click OK.

10. In the Apply Onto drop-down list, click User Objects.

11. In the Allow column, select the Send As check box.

12. Click Apply.

13. Click OK.

Enable MAPI profiles 
> To initialize the Messaging Application Programming Interface (MAPI) subsystem, open the Microsoft 

Exchange 2000 or Microsoft Exchange 2003 System Manager.

If MAPI is not present after completing this step, you might need to run a tool that enables the BlackBerry 
Enterprise Server installation to facilitate MAPI profile creation and editing. See “Resolving issues during the 
installation process” on page 33 for more information. 

Set the permissions using the 
Exchange Management Shell for 
Microsoft Exchange 2007.

1. Open the Exchange Management Shell.

2. Type one of the following commands:

• If you are performing the command locally on the Microsoft Exchange 2007 Server:

add-exchangeadministrator “BESAdmin” –role ViewOnlyAdmin

• If you are performing the command from another computer:

set-mailboxserver “<messaging_server_name>” | add-exchangeadministrator 
“BESAdmin” –role ViewOnlyAdmin

3. Type the following command:

set-mailboxserver “<messaging_server_name>” | add-adpermission –user “BESAdmin”  
–accessrights ExtendedRight –extendedrights Send-As, Receive-As, ms-Exch-Store-
Admin

Action Procedure
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Configuring Microsoft Exchange to support wireless calendar synchronization
The BlackBerry Enterprise Server uses Microsoft Exchange System Manager tools to support wireless calendar 
synchronization with the Microsoft Exchange messaging server. 

The version of the Microsoft Exchange System Manager tools that you install on the BlackBerry Enterprise Server 
must match the version—including service pack—that is installed on your messaging servers. 

RIM recommends that you review the Microsoft known issues that might impact your messaging environment. If 
you experience a problem that is described in an article and have not upgraded your messaging servers to the 
service pack that contains the fix, download and install the hotfix on the computer where you plan to install the 
BlackBerry Enterprise Server. 

If your BlackBerry Enterprise Server connects to multiple messaging servers, select the hotfix that is applicable to 
the latest version of the Exchange software in your environment.

Review the following Microsoft known issues that might impact your messaging environment. 

Setting database permissions
When you run the setup program, the account that you use must have permissions on the database server. The 
type of permission depends on the setup type that you choose and whether you are creating the BlackBerry 
Configuration Database on the same computer as the BlackBerry Enterprise Server or on a remote database 
server.

If you create the BlackBerry Configuration Database on the same computer as the BlackBerry Enterprise Server, 
you also install a custom event-based notification system that is designed to reduce the number of database 
queries that the BlackBerry Enterprise Server makes to the BlackBerry Configuration Database. You require a 
higher level of permission for this installation because you must register this database notification system.

If you create the BlackBerry Configuration Database on a remote database server, you do not install the database 
notification system automatically, so you require a lower level of permission. You can install the database 
notification system manually after you complete the setup program. See “Install the database notification system” 
on page 32 for more information.

If you install the BlackBerry MDS Services, you must use a database login instead of a Microsoft Windows account 
to create and access the BlackBerry MDS Services databases. If you are using a database login to create the 
BlackBerry Configuration Database, you must use a different login for the BlackBerry MDS Services databases. 

Note: Verify that you meet the requirements described in the hotfix before you install it.

Microsoft Exchange System Manager tools Microsoft knowledge base articles

Microsoft Exchange Version 5.5 Administrator • www.support.microsoft.com/kb/312273

• www.support.microsoft.com/kb/818709

Microsoft Exchange 2000 System Manager • www.support.microsoft.com/kb/314606

• www.support.microsoft.com/kb/824960

Microsoft Exchange 2003 System Manager • www.support.microsoft.com/kb/823343

• www.support.microsoft.com/kb/894470
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3: Configuring your environment
The BlackBerry MDS Services store their BlackBerry MDS Service database access credentials in plain text form in 
<installation directory>\MDSS\jakarta-tomcat-5.5.9\conf\server.xml. To protect the access credentials in that 
storage location, you must limit read and write control to that location.

If you install MSDE 2000 during the BlackBerry Enterprise Server installation, you do not need to set additional 
permissions. When you select Windows (trusted) authentication during the BlackBerry Enterprise Server 
installation, the required permissions are given to the account that you used to run the setup program.

Visit http://msdn2.microsoft.com/en-us/library/aa905156(SQL.80).aspx for more information about Microsoft 
SQL Server security.

Set Microsoft SQL Server permissions
> Perform one of the following actions:

Action Procedure

Create the BlackBerry Configuration Database on the same computer 
as the BlackBerry Enterprise Server and register the database 
notification system.

> Assign System Administrator permissions.

Create the BlackBerry Configuration Database on a remote database 
server during the BlackBerry Enterprise Server installation.

> Assign Server Administrator and Database Creator 
permissions. If you are using Microsoft SQL Server 2005, 
also assign the System Administrator permission or the 
following roles: SQLAgentUserRole, 
SQLAgentReaderRole, and SQLAgentOperatorRole.

Create the BlackBerry MDS Services databases during the BlackBerry 
MDS Services or BlackBerry Enterprise Server with BlackBerry MDS 
Services installations.

> Assign System Administrator permissions.
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4

Installing the BlackBerry Enterprise Server 
software

Checklist: Confirm BlackBerry Enterprise Server installation 
requirements
Use the following checklist to confirm that you are ready to start the installation:

Checklist: Confirm BlackBerry Enterprise Server installation requirements
Install the BlackBerry Enterprise Server
Install a BlackBerry component on a remote computer
Install the database notification system
Installing the Hosted BlackBerry for Microsoft Exchange
Troubleshooting the BlackBerry Enterprise Server installation process
Postinstallation tasks

Step

Select a setup type. See “Choosing a BlackBerry Enterprise Server setup type” on page 7 for more information.

Verify that you have met all the system requirements. See “System requirements for the BlackBerry Enterprise Server” on page 11 
for more information.

Create the required accounts for the messaging server to access the BlackBerry Enterprise Server. See “Enabling the messaging 
environment to communicate with the BlackBerry Enterprise Server” on page 25 for more information.

Log in to the computer using the service account with the appropriate server administrator and database permissions. See 
“Setting database permissions” on page 28 for more information.

Note: The service account is added automatically to the Security administrator role in the BlackBerry Configuration Database.

Confirm that you have the following required credentials from the BlackBerry Enterprise Server installation media:

• client access license key

• SRP identifier

• SRP key

• SRP host

Confirm that you have the following required installation credentials from your environment:

• computer name and port number of the messaging server

• name of the mailbox that you created for the BESAdmin service account

• computer name and port number of the instant messaging server (use the virtual server name and port number where the 
AJAX service is installed, if applicable in your environment)

• computer name and port of the proxy server

Note: If you are using a .pac file to configure the connection, you can specify that file after you complete the installation process.
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Install the BlackBerry Enterprise Server
You add BlackBerry Enterprise Servers to a BlackBerry Domain by specifying a shared BlackBerry Configuration 
Database during the installation process. 

1. Log in to your computer using the BESAdmin service account that you created.

2. Double-click setup.exe.

3. Complete the instructions on the screen. 

4. When prompted to restart the computer, click Yes.

5. Log in using the same account that you used for the setup program.

6. Complete the instructions on the screen. 

7. If you are using Microsoft Exchange 2003 and use calendars with unicode text, complete the following 
actions:

a) On the BlackBerry Enteprise Server, open the Registry Editor.

b) In the left pane, navigate to \\HKEY_LOCAL_MACHINE\software\Research In Motion\BlackBerry 
Enterprise Server\Agents.

c) Create a DWORD value named SetLocaleIDs.

d) Set the value to 1.

e) In the Microsoft Windows Services, restart the BlackBerry Messaging Agent.

Install a BlackBerry component on a remote computer
1. Log in to your computer using the BESAdmin service account that you created.

2. Double-click setup.exe.

3. Complete the instructions on the screen. 

4. When prompted to restart the computer, click Yes.

5. Log in using the same account that you used for the setup program.

6. Complete the instructions on the screen. 

Install the database notification system
1. Connect to the Microsoft SQL Server instance using an account with System Administration permission.

2. Copy RimEsp.dll to C:\Program Files\Microsoft SQL Server\MSSQL\Binn. 

3. In the SQL Query Analyzer, browse to the <drive>\Database\DBInstallScripts\SQLServer\4.1 folder on the 
installation media.

4. Open NotifyInstall.sql and replace <_DATABASENAME_> with the name of your BlackBerry Configuration 
Database.
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5. Run the script.

6. Confirm that the SQL Query Analyzer displays the message “Function dbo.xp_RIM_xxxx registered.”

7. Repeat steps 1 through 6 for additional BlackBerry Configuration Databases in your environment.

Installing the Hosted BlackBerry for Microsoft Exchange
If you are installing the Hosted BlackBerry® for Microsoft Exchange, the installation recommendations, 
requirements, and procedures are identical to those for the BlackBerry Enterprise Server. The Hosted BlackBerry 
for Microsoft Exchange is a version of the BlackBerry Enterprise Server that you can provide to an organization. It 
includes all of the services and components of the BlackBerry Enterprise Server, but uses a different licensing 
model. 

Depending on how you set up your hosted environment, additional configurations might be required after 
installation. See the BlackBerry Enterprise Server Version 4.1.4 System Administration Guide for more information 
about configuring a hosted environment.

Troubleshooting the BlackBerry Enterprise Server 
installation process

Resolving issues during the installation process

Symptom Possible solution

One of the third-party tools installed by the setup 
program does not install successfully and the setup 
program ends.

1. In the BlackBerry Enterprise Server installation media, open the Tools folder and 
locate the program that you want to install.

2. Install the third-party tool manually.

3. Restart the setup program.

When you start the setup program, the message 
“Previous version detected but no database available” 
appears and the setup program ends.

Verify that the registry keys identifying your BlackBerry Configuration Database are 
present.

1. On the computer on which you plan to install the BlackBerry Enterprise Server, 
start the Registry Editor.

2. In the left pane, browse to HKEY_LOCAL_MACHINE\Research In Motion\ 
BlackBerry Enterprise Server\Database.

3. Create the following string values (if they do not exist):

• DatabaseName: Type the name of the BlackBerry Configuration Database.

• DatabaseServerMachineName: Type the computer name of the database 
server.

Note: These values are case sensitive.

4. Restart the setup program.
33



BlackBerry Enterprise Server for  Microsoft Exchange Installation Guide
Resolving issues after the installation process completes

Postinstallation tasks

After you attempt to add the client access license key, 
the “Failed to write License Key to the Database” 
message appears.

Verify that you logged in to the computer using the same account after restarting the 
computer.

1. Cancel the setup program.

2. Log off the computer.

3. Log in to the computer using the same account that you used to start the 
installation process.

4. Restart the setup program.

You were not prompted to edit or confirm the MAPI 
profile during the installation.

You can create and edit the MAPI profile manually.

1. In the BlackBerry Enterprise Server installation media, in the Tools folder, 
double-click the Fixmapisvc.exe file. 

2. Verify that the mapisvc.inf file is installed at C:\winnt\system32\ or 
C:\windows\system32\.

3. On the taskbar, click Start > BlackBerry Enterprise Server > Edit MAPI Profile.

4. Type the Microsoft Exchange Server name. 

5. Select the mailbox associated with the MAPI profile.

6. Click OK.

When you install SP1 to a previously installed version 
of Microsoft .NET Framework Version 1.1, the setup 
program prompts you for access to the original 
installation media for Microsoft .NET Framework 
Version 1.1.

1. When the setup program prompts you for the location of netfx.msi, browse to the 
Tools folder in the BlackBerry Enterprise Server installation media.

2. Click the file.

Symptom Possible solution

The BlackBerry Collaboration Service is not connecting to 
Microsoft Live Communications Server 2005.

If your instant messaging environment supports Microsoft Windows 
Messenger and you are using TLS as the communication protocol, verify that 
authentication is configured.

1. Visit www.microsoft.com/downloads to download Microsoft Office 
Communicator 2005 Trial Edition.

2. Install the Microsoft Office Communicator 2005 client on the computer 
where the BlackBerry Collaboration Service is located. 

3. Use Microsoft Office Communicator 2005 to connect to Microsoft Live 
Communications Server 2005.

4. If a connection cannot be made, confirm that you have installed or 
imported the required authentication certificates. 

Action Resource

Add administrators to roles. BlackBerry Enterprise Server Version 4.1.4 System Administration Guide

Add users to the BlackBerry Enterprise Server. BlackBerry Enterprise Server Version 4.1.4 System Administration Guide

Symptom Possible solution
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4: Installing the BlackBerry Enterprise Server software
Configure the connection between the BlackBerry MDS Connection Service 
and a remote BlackBerry Attachment Service
1. On the computer on which the BlackBerry MDS Connection Service is running, browse to C:\Program 

Files\Research In Motion\BlackBerry Enterprise Server\MDS\Servers\Instance\config.

2. Open rimpublic.property in a text editor.

3. Add the following lines:
Attachment.Server.host=<attachment_server_hostname>
Attachment.Server.port.asp=1900
Attachment.Server.port.rqp=2000 

4. Save and close the file.

5. In the Microsoft Windows Services window, restart the BlackBerry MDS Connection Service service.

6. Complete steps 1 through 5 for every BlackBerry MDS Connection Service that is connecting to a remote 
BlackBerry Attachment Service.

7. On the computer on which the remote BlackBerry Attachment Service is running, open the Registry Editor.

8. In the HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion\BBAttachServer\BBAttachBESExtension 
key, change the AllowRemoteServices value to 1. 

9. In the Microsoft Windows Services window, restart the BlackBerry Attachment Service service.

Configure the BlackBerry Enterprise Server for Microsoft Exchange 2003 to 
support unicode text in calendars
You must have installed the appropriate hotfixes for Microsoft Exchange 2003. See “Checklist: Messaging and 
collaboration environment settings” on page 15 for more information.

1. On the BlackBerry Enteprise Server, open the Registry Editor.

2. In the left pane, navigate to \\HKEY_LOCAL_MACHINE\software\Research In Motion\BlackBerry Enterprise 
Server\Agents.

3. Create a DWORD value named SetLocaleIDs.

4. Set the value to 1.

5. In the Microsoft Windows Services, restart the BlackBerry Messaging Agent.

Implement BlackBerry devices. BlackBerry Enterprise Server Version 4.1.4 System Administration Guide

Configure a connection between the BlackBerry Enterprise 
Server and the BlackBerry MDS Services.

BlackBerry Enterprise Server Version 4.1.4 System Administration Guide

Action Resource
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5

Removing the BlackBerry Enterprise Server 
software

Remove the BlackBerry Enterprise Server software
The Java Runtime Environment and Java Web Start software is not removed when you remove the BlackBerry 
Enterprise Server from your computer. You must remove these applications manually.

1. On the taskbar, click Start > Settings > Control Panel > Add/Remove Programs.

2. Click BlackBerry Enterprise Server.

3. Click Remove. 

4. Click Yes.

Remove registry entries from your computer
1. On the computer from which you removed the BlackBerry Enterprise Server software, start the Registry Editor.

2. Delete any of the following registry entries:

Remove the BlackBerry Enterprise Server software
Remove registry entries from your computer
Remove the database notification system

Entry Location

Research In Motion HKEY_LOCAL_MACHINE\Software\

BBAttachServer and any keys starting with “BES” or 
“BlackBerry”

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\

HKEY_LOCAL_MACHINE\System\ControlSet001\Services\

HKEY_LOCAL_MACHINE\System\ControlSet002\Services\

Research In Motion HKEY_CURRENT_USER\Software\

any keys named BlackBerryServer, BlackBerry Server 
Management, or listed as the name of your BlackBerry 
Enterprise Server

HKEY_CURRENT_USER\Software\Microsoft\Windows NT\ 
CurrentVersion\Windows Messaging SubSystem\Profiles\

Research In Motion HKEY_USERS\.DEFAULT\Software\

BESManmmc.dll HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion
\App Paths\

any key in which the ProductName is BlackBerry Enterprise 
Server

HKEY_CLASSES_ROOT\Installer\Products\
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Remove the database notification system
You might have to restart the Microsoft SQL Server to complete the removal of the database notification system. If 
you do not want to restart the server, rename the RimEsp.dll file (for example, to RimEspXXX.tmp).

1. In the SQL Query Analyzer, browse to the <drive>\Database\DBInstallScripts\SQLServer\4.1 folder on the 
installation media.

2. Open NotifyUnInstall.sql.

3. Perform one of the following actions:

Action Procedure

Remove the database notification system from one 
BlackBerry Configuration Database.

1. Remove all commands after -- delete notification stored 
procedures and -- delete notification tables.

2. Run the script.

Remove the database notification system from all BlackBerry 
Configuration Databases.

1. Run the script.

2. At C:\Program Files\Microsoft SQL Server\MSSQL\Binn, 
remove RimEsp.dll.
38





©2007 Research In Motion Limited

Published in Canada.


	Contents
	Planning your BlackBerry environment
	Choosing a BlackBerry Enterprise Server setup type
	Upgrading the BlackBerry Enterprise Server

	System requirements
	Hardware requirements
	System requirements for the BlackBerry Enterprise Server
	Checklist: Operating system requirements
	Checklist: Messaging and collaboration server software requirements
	Checklist: Security support requirements
	Checklist: Multilanguage support requirements
	Checklist: Virtual machine support requirements
	Checklist: Additional software requirements

	System requirements for your corporate environment
	Checklist: Network environment settings
	Checklist: Messaging and collaboration environment settings
	Checklist: Instant messaging environment settings
	Checklist: Terminal service settings
	Checklist: Database environment settings

	System requirements for remote components
	Checklist: BlackBerry MDS Services system requirements
	Checklist: BlackBerry Enterprise Server with the BlackBerry MDS Services system requirements
	Checklist: BlackBerry Attachment Service system requirements
	Checklist: BlackBerry Manager system requirements
	Checklist: BlackBerry Router system requirements
	Checklist: BlackBerry MDS Connection Service system requirements
	Checklist: BlackBerry Collaboration Service system requirements


	Configuring your environment
	Enabling the messaging environment to communicate with the BlackBerry Enterprise Server
	Create a service account and mailbox
	Configure Microsoft Windows permissions for the service account
	Configure Microsoft Exchange permissions for the service account
	Enable BlackBerry users to send messages when using Microsoft Exchange 2007
	Enable MAPI profiles
	Configuring Microsoft Exchange to support wireless calendar synchronization

	Setting database permissions
	Set Microsoft SQL Server permissions


	Installing the BlackBerry Enterprise Server software
	Checklist: Confirm BlackBerry Enterprise Server installation requirements
	Install the BlackBerry Enterprise Server
	Install a BlackBerry component on a remote computer
	Install the database notification system
	Installing the Hosted BlackBerry for Microsoft Exchange
	Troubleshooting the BlackBerry Enterprise Server installation process
	Resolving issues during the installation process
	Resolving issues after the installation process completes

	Postinstallation tasks
	Configure the connection between the BlackBerry MDS Connection Service and a remote BlackBerry Attachment Service
	Configure the BlackBerry Enterprise Server for Microsoft Exchange 2003 to support unicode text in calendars


	Removing the BlackBerry Enterprise Server software
	Remove the BlackBerry Enterprise Server software
	Remove registry entries from your computer
	Remove the database notification system



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /OK
  /CompatibilityLevel 1.3
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages false
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages false
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages false
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /FRA <>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /ENU <FEFF005500730065002000740068006500730065002000730065007400740069006e0067007300200074006f0020006300720065006100740065002000500044004600200064006f00630075006d0065006e00740073002e>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


